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Chapter 1

Laplace

1.1 usage

- Laplace Manual ←↩
----------------------------------------------------- Usage -

3) Using Laplace

Laplace works much like a shell, you enter an expression, press return and
Laplace gives you the result (after some time;-).

To learn about the input format that is used to tell Laplace, what it
should do, have a look at the expression syntax.

When a new window is opened, Laplace confronts you with an empty environ-
ment. In most cases you will include the standard libraries using
include("init.lh");, that’s why this expression is always inserted as a de-
fault. You just have to press return to execute this expression, and continue
with your work.

To avoid confusion, a line (consisting of your input and the result) is
from now on called an entry , because itself may consist of several lines .

Each entry consists of two parts: your input and the result. Your input may
consist of several line and always starts at an input prompt.

*
Hierarchical structure

*
The graphical interface

*
Editmodes

*
History

*
Clipboard
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*
The menu

*
The toolbar

*
The keyboard

*
About mice and men...

*
The preferences window

*
Projects

------------------------------------------------------------------ © by P!\K -

1.2 structure

- Laplace Manual ------------------------------------ Hierarchical structure -

3.1) Hierarchical structure

Laplace works strictly hierarchically. This means that all the results of
an entry can only influence the following entries. There is usually no way to
have a backward effect . If you define a variable or function, it can only be
referenced from the following entries. In the preceding entries it’s just un-
known . If you later assign a new value to this variable, the old value is not
discarded; it can still be used in the intervening entries, e.g.
> ... (a is unknown here)
> a := 5; (a evaluates to 5)
> ...
> ...
> a := 7; (a now evaluates to 7, but remains 5 in the preceding entries)
> ...

------------------------------------------------------------------ © by P!\K -

1.3 gui

- Laplace Manual ----------------------------------- The graphical ←↩
interface -

3.2) The graphical interface

Laplace presents you a (hopefully) comfortable graphical interface. You can



Laplace 3 / 9

open as many windows as you want, each window has it’s own environment and you
can work with several projects simultaneously.

Laplace features bubble help. Just leave the mouse pointer on an item and
wait a moment and a short description will be shown.

Edit windows

Each window is separated into three major parts: the
toolbar
at the top, an

statusbar at the bottom and the main editing area in the middle.

The leftmost field of the statusbar just displays whether you modified the
current project since the last time that you saved it. It’s right neighbour is
a cycle gadget that lets you select the current

editmode
. The remaining space

is filled by a text-field that displays the current cursor position.

But the most interesting thing is the big area that fills up most of the
window. Here the action takes place. You can scroll around in this area using
the two sliders at the right and bottom. Laplace works just like a shell, you
enter a command line, Laplace displays the result and you advance to the next
line and so on. The main difference is that you can move up and make some mod-
ifications that may influence the results of the following lines.

The scheduler window

Apart from the windows, where you enter your formulas, there is one small
window that always appears, while Laplace is running. It’s something like a
main-control-panel . At the bottom is a text field that displays the state of
Laplace’s calculation engine. Each time when a calculation has finished, the
elapsed time is displayed. The abort-button can only be used with asynchron
calculation; it will interrupt the current calculation.

The scheduler window has it’s own menu:

· Project
· About - Show some information about Laplace.
· New window - Open a new and empty window.
· Preferences... - This will open the preferences window. See

preferences
for more information.

· Quit - Close all windows and exit Laplace. If there are recent
changes, you will be asked whether you want to save the changes,
but you cannot abort this operation.

· Hidden This menu has a special meaning. If you hide an edit window,
it’s title will appear in the menu. Selecting this entry will reopen the
window.

------------------------------------------------------------------ © by P!\K -
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1.4 editmodes

- Laplace Manual ------------------------------------------------- Editmodes -

3.3) Editmodes

Sometimes you want to enter a long expression or a definition of a proce-
dure. It would be quite annoying to do this in a single line. Laplace offers
two different modes for this reason (the only difference is the handling of
the return-key). If you are in singleline mode , pressing return tells Laplace
to evaluate the expression, return the result to you and advance to the next
entry. In multiline mode return adds a new line to the current entry in the
same way as you know it from a usual text editor. You can split an expression
at every point, where a space is allowed, Laplace doesn’t distinguish between
spaces and line breaks.

Holding down the shift key reverses the effect: press shift-return to eval-
uate an expression while you are in multiline mode, or to split a line while
you are in singleline mode.

------------------------------------------------------------------ © by P!\K -

1.5 history

- Laplace Manual --------------------------------------------------- History -

3.4) History

Laplace offers an easy way to copy some input that you already used before.
Hold down the control key and press the up or down key. Then the contents of
the succeeding or proceeding entry will be copied to the current entry. By re-
peatedly pressing the up/down key you can move further up or down in the list
of entries.

------------------------------------------------------------------ © by P!\K -

1.6 clipboard

- Laplace Manual ------------------------------------------------- ←↩
Clipboard -

3.5) Clipboard

Laplace supports the global clipboard. You can mark some text using the

mouse
and then cut it out or just copy it to the clipboard. You can ←↩

later
paste in the contents of the clipboard at the cursor position. Since the
clipboard is global to all applications you can easily exchange short parts of



Laplace 5 / 9

text between different programs. Laplace uses the clipboard unit zero.

------------------------------------------------------------------ © by P!\K -

1.7 menu

- Laplace Manual ←↩
-------------------------------------------------- The menu -

3.6) The menu

A menu is connected to each window. Some actions only apply to the active
window, but some are global to all windows (e.g. Quit ;-).

Many menu items have a keyboard shortcut, e.g. A-l for Load...: Holding
down the right AMIGA-key and pressing l works just like activating the item
with your mouse.

Some menu items are marked by some trailing dots, like Save as.... This
means that more user input is required, if you select this entry. Otherwise
some action is immediately performed.

The menustrip is now fully configurable. At this place I will give you a
description of the default configuration.

The Project menu

· About - Show some information about Laplace.
· New window - Open a new and empty window.
· Open... - Opens a requester where you can choose a project to be opened.
If the current window is empty, it will be used, otherwise a new window
is opened.

· Load... - Similar to Open..., except that it will always use the current
window.

· Save - Save the current project under it’s old name. If you haven’t cho-
sen a name for it, this works just like Save as...

· Save as... - Opens a requester where you can choose the path and name
for the current project and save it. The selected name will be used if
you select Save at a later moment.

· Import... - Read a project from an ASCII file.
· Export... - Write the current project as an ASCII file.
· Hide - This will temporarily close the current window. A new menu item

in the Hidden-menu of the scheduler window. Selecting this item will re-
open the window.

· Close - Close the current window. If there are some recent changes that
are not saved, you will be asked what should be done. When you close the
last window, Laplace will quit.

· Quit - Close all windows and exit Laplace. Again you will be asked, if
there are recent changes, but you cannot abort this operation.

The Edit menu

· Mark all - This marks all characters of the current entry, just as if
you used the mouse for this.
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· Unmark - If there is some text marked in the current entry, this mark
will be removed.

· Cut - Cut out the currently marked text and copy it to the
clipboard
.

· Copy - Copy the currently marked text to the
clipboard

and leave it
where it is.

· Paste - The text from the
clipboard
is inserted at the current cursor

position.

The Entries menu

· Insert - Insert a blank entry just before the current one, and make the
new one active.

· Remove - Removes the current entry including it’s result (if there is
one).

· Remove all - Clear all entries in the current window.
· Clear result - Discard the result of the current entry. This will also

remove all definitions, options etc. associated with this entry.
· Clear all results - Discard the results of the all entries. This will

also remove all definitions, options etc.

The Preferences menu

· Global... - This will open the preferences window. See
preferences

for
more information.

· Plotter... - Open the settings window for the plotter. You can edit the
global settings that are used as default when a new plotter is opened.

------------------------------------------------------------------ © by P!\K -

1.8 toolbar

- Laplace Manual ----------------------------------------------- ←↩
The toolbar -

3.7) The toolbar

The toolbar at the top of each window offers you a fast access to some
functions that are usually available in the menu.

Just like the menu strip, you can configure the toolbar freely. Again, this
is only a description of the default configuration.

· Cut - Cut out the currently marked text and copy it to the clipboard.
· Copy - Copy the currently marked text to the clipboard and leave it
where it is.

· Paste - The text from the clipboard is inserted at the current cursor
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position.
· Preferences - This will open the preferences window. See

preferences
for

more information.

------------------------------------------------------------------ © by P!\K -

1.9 keyboard

- Laplace Manual ---------------------------------------------- ←↩
The keyboard -

3.8) The keyboard

Probably most work is done using your keyboard. I think that most functions
are straight ahead as you would expect it (and know it from common text edi-
tors), but you may adjust the keyboard mapping to your own requirements.

If you are working with asynchron calculation, you can interrupt the cur-
rent calculation by pressing control-c. You cannot change this key
combination.

If you enable erase block in the preferences window and there is some text
marked, this text is replaced by your input. Without erase block the mark is
abolished.

There are two unusual keys that Laplace uses: $\times$ and \ensuremath{\pm}. $ ←↩
\times$ is not the usual

x, but can be entered by alt-x. To enter the \ensuremath{\pm} sign press alt-y on ←↩
German key-

boards or alt-z on other boards (the same key, just another label).

Here is the key mapping of the default configuration:

· left, right, up, down - Cursor movement. If you move across the border
of the current entry, you jump to the next/previous entry.

· shift-left, shift-right - Jump to the next/previous word.
· alt-left, alt-right - Jump to the beginning/end of the current line.
· shift-up, shift-down - Jump to the first/last line of the current entry.
· alt-up, alt-down - Jump to the entry that is just above/below the visi-

ble part.
· shift-alt-up, shift-alt-down - Jump to the first/last entry.
· control-up, control-down - Move one step forward/backward in the

history
buffer.

· shift-control-up, shift-control-down - Move to the first/last entry in
the

history
buffer.

· backspace - Delete the preceding character.
· shift-backspace - Delete to the beginning of the current line.
· delete - Delete the succeeding character.
· shift-delete - Delete to the end of the current line.
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· alt-delete - Clear the result of the current entry.
· enter - Singleline mode : Evaluate the current line and proceed to the
next entry. Multiline mode : Insert a new line to the current entry.

· shift-enter - Singleline mode : Insert a new line to the current entry.
Multiline mode : Evaluate the current line and proceed to the next
entry.

------------------------------------------------------------------ © by P!\K -

1.10 mouse

- Laplace Manual ------------------------------------- About mice ←↩
and men... -

3.9) About mice and men...

You can use the mouse to change the active entry or to mark some text,
thereby you can then make use of the

clipboard
.

If you make a double click on an entry, this has the same effect as press-
ing return: The expression will be evaluated and the result is shown.

------------------------------------------------------------------ © by P!\K -

1.11 preferences

- Laplace Manual ------------------------------------ The preferences window -

3.10) The preferences window

Almost everything configureable...

Sorry, no docs written now. But I think, most parts should be
self-explaining.

------------------------------------------------------------------ © by P!\K -

1.12 projects

- Laplace Manual ←↩
-------------------------------------------------- Projects -

3.11) Projects

Projects are usually placed in the Projects directory.
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Laplace uses now a binary file format. This offers the new possibility to
load a project in (almost) exactly the same state as you saved it, including
all results, definitions and options. You can enable this feature in the

preferences
window.

If you still want to import a project in your favorite ASCII editor, you
can use the Export... function from the Project menu. This will create a file
only with the input lines, each one seperated by a blank line. You can also
Import... such an ASCII file.

------------------------------------------------------------------ © by P!\K -
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